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Pinochle Help Contents

Welcome to MeggieSoft Games' Pinochle. Help is organized in the following sections. Click on the one you
require. Alternatively, click on the search button above to look for information on a specific subject.

Introduction

How to Play Pinochle
Understanding the Interface
Menus

Miscellaneous Information

About MeggieSoft Games

This help system is constructed so that you may cycle through each topic and return to this Contents panel.
In this way you may easily review all the help information associated with one of the above topics. Cycling is
achieved by clicking the links at the top of each panel. To return here from any topic panel, press the
Contents button at the top.



% Cycle back to: Contents
Introduction

Pinochle adheres to the rules of two-handed Pinochle documented in Hoyle's Rules Of Games, and provides
common rule variations.

Twelve cards are dealt to each player in groups of three. The remaining cards are placed face down by the
mat as the stock. The top card is turned face up and placed under the stock to define the trump suit for the
round. The round starts with the leader playing a card to the mat; the other player follows. Each round is
comprised of two phases of taking tricks. After each trick, each player takes a new card from the stock until it
is depleted, thus ending the first phase.

During the first phase, one need not follow suit, but one may trump. During the first phase only, each player
earns points by melding cards in their hand after taking a trick. When the stock has been depleted, melded
cards are returned to the players' hands and the second phase of the round starts. During the second phase,
players must follow suit if they can, must win a trump trick if they can, and must must trump if they cannot
follow suit. During the second phase, points are won for taking tricks. In each phase, the leader wins a trick
unless the following plays a higher card of the suit, or trumps it.

A round ends after the twelve tricks of the second phase have been played. Successive rounds are dealt and
played until one of the players achieves the goal of 1000 points to win the game.



% Cycle back to: Contents

How to Play Pinochle

The following is the sequence of each of player's turn:

1 Playing one of the cards from those in your hand to lead to a trick, or follow the opponent's lead.
2 Melding cards if you are able.

Taking a new card from the stock (first if you won the previous trick, otherwise after the opponent takes a
card). When the stock is exhausted, play moves into the second phase.

During the second phase, the remaining cards are played as tricks (no further melding may take place).
Points are scored for taking tricks.

The Deal

Playing A Card

Melding Cards

Taking A Card From The Stock
Melding Options

Meld Scoring

Trick Scoring

Ending A Game
Getting Started - Phase 1

Getting Started - Phase 2
Watching a Game Being Played




E Next panel: Playing A Card

The Deal

The first round is dealt automatically after you confirm that you will start the first round, or after the cut for
deal (if this option is selected).

After the end of each round, Pinochle will shuffle and deal the cards for the next round.

At the end of each game, you will be asked if you want to proceed with the next game. If you select "Yes",
Pinochle will shuffle and deal the cards.

At any time, you may select "Redeal Game" from the Game menu. In this case, the current game is
abandoned, and the cards are reshuffled and redealt. Alternatively, you can select "Restart Round", in which
case the cards are not shuffled and the current round is restarted.

If "AutoMouse Cards" is enabled, the mouse pointer will be moved automatically to the player's hand after
the cards have been dealt.



E Next panel: Melding Cards
Playing A Card

Each turn is comprised of each player by playing one of the cards in their hand. Whomever won the previous
trick of a round leads to the next.

During phase 1, while the stock is not exhausted, the other player may follow with any card in their hand,
including their melded cards. The trick is won by the second player if they play a higher card of the same suit
or a trump card. Otherwise the trick is won by the first player.

During phase 2, the following rules apply when following the other player's lead: If you can follow suit, you
must do so; when following suit and a trump suit was led, you must win the trick with a higher card if you
have one; if you cannot follow suit, you must play a trump if you have one.

To play a card, position the mouse pointer over the card and click the RIGHT mouse button. Alternatively,
you may click the LEFT mouse button with the ALT key depressed. Alternatively, you may drag and drop a
card directly from your hand to the mat.

If you have selected "Play Protect" under the "Player" tab of the "Preferences" menu option, a confirming
popup menu will appear when you click on the right mouse button.

Note that you cannot play a card to the mat while cards are highlighted. You must deselect any highlighted
cards first.



E Next panel: Taking A Card From The Stock

Melding Cards

You may create a new meld whenever you have just taken a trick. If the "Dix Alone" rule option is not
selected, you may meld one or both Dixes in the same turn as another meld. Otherwise, a Dix is treated as
the single meld permitted per trick won.

The first Dix melded will be exchanged with the upturned trump card (under the stock) if it is not itself a Dix.

You meld a card by clicking on it (it will then be highlighted, click on it again if you wish to deselect it), and
then clicking to the right of your hand. Or you may drag the card directly to the right of your hand.

To create a new meld, place the card in the clear area to the right of your hand. To add to an existing meld,
place the card on top of the meld.

Multiple cards may be melded in a group (select each first), or singly. If you meld singly, you must complete
the meld before starting another or discarding. Use the "Undo" feature if you make an error.



E Next panel: Melding Options

Taking A Card From The Stock

To take a card from the stock, position the mouse pointer over the face down card on top of the stock. (In
AutoMouse mode, the mouse will have been automatically positioned over the stock after you played the
previous card, if you had nothing to meld.)

Click down with either the left mouse button on the card.

The card will then be displayed face up for you to see it. When you release the mouse button, it will be
removed from the stock and added to your hand, which will immediately be sorted.

If AutoMouse mode is operative, the mouse pointer will also move to your hand and point to the card taken.



E Next panel: Meld Scoring
Melding Options
The melds are:
Dix: Nine of Trumps
Pinochle: Jack of Diamonds plus Queen of Spades
Marriage: Queen and King of a non-Trump suit
Royal Marriage: Queen and King of the Trump suit
Forty Jacks: Four Jacks of different suits
Sixty Queens: Four Queens of different suits
Eighty Kings: Four Kings of different suits
Hundred Aces: Four Aces of different suits
Flush: Ten, Jack, Queen, King, Ace of the Trump suit
Roundhouse (if selected): Four Queens of different suits plus four Kings of different suits

Each meld must include at least one previously unmelded card; a card which has already been melded as
part of a set (Jacks, Queens, Kings, or Aces) may not be melded as part of another set or a roundhouse; a
card which has already been melded as part of a marriage may not be melded as part of another marriage or a
roundhouse; a card which has already been melded as part of a flush may not be melded as part of a
marriage, but a card which has already been melded as part of a marriage may be melded as part of a flush; a
card which has already been melded as part of a roundhouse may not be melded as part of a marriage or a
set.



E Next panel: Trick Scoring

Meld Scoring

During the first phase, points are earned as each meld is laid down. The points values of melds are:
10 Points : Dix

20 Points : Pinochle, Marriage

40 Points : Royal Marriage, Four Jacks

60 Points : Four Queens

80 Points : Four Kings

100 Points : Four Aces

150 Points : Flush

220 Points : Roundhouse (if rule option selected)

The first Dix melded during a round will be exchanged with the upturned trump card (under the stock) if it is
not itself a Dix.

A player wins the game by reaching the goal of 1000 points before the other. If both players reach the goal
together, the goal is extended by 250 points (continually if necessary, until one player has won). If one of
the players reaches the goal during melding, they may knock and declare the game completed. The
opponent will knock automatically. You may set the appropriate option under the "Assistant" menu if you wish
to knock automatically; otherwise, you must knock yourself by clicking on the table to the right of where the
tricks are played.



E Next panel: Ending A Game

Trick Scoring

During the second phase, points are earned for each trick taken but are added to the players' scores only after
the end of the round. The points value of a trick is determined by adding together the points value of each
card in the trick. The points values of trick cards are:

11 Points : Ace

10 Points : Ten

4 Points : King

3 Points : Queen

2 Points : Jack

Ten points may also be awarded for taking the last trick, if the corresponding rule option is selected.

If you have selected the rule variation to score tricks using the simplified method, the trick points are:
10 Points : Ace and Ten
5 Points : King and Queen (no points for Jack)

A rule option is available whereby tricks may be scored during the first phase also.



E Next panel: Getting Started - Phase 1

Ending A Game

A game normally ends when one of the players has accumulated the goal of 1000 points or more. The goal is
displayed to the right of the status bar at the bottom of the Pinochle window.

If, at the end of a round, both players have passed the goal, the goal is incremented by 250 points. This can
happen repeatedly until one player is the clear winner.

A player who passes the goal during the melding phase of a round may knock by clicking on the right side of
the mat. This action ends the game before the end of the round. The opponent will always knock
automatically. The player may set the "AutoKnock" option preference to knock automatically, if desired.



E Next panel: Getting Started - Phase 2

Getting Started - Phase 1

When you first start Pinochle, you will see a "Start" button in the status bar. If you wish to make any menu
option changes before starting, now is a good time to do this. Then click on the start button. The first round
of the first game starts with your turn, which you make by playing a card from your hand, by clicking on it with
the RIGHT mouse button. The lead alternates for each successive round.

After you have played your card, the opponent will play a card. If the opponent's card is a higher card of the
same suit, or if it is a card of the trump suit and your card was not a trump, then the opponent takes the trick.
Otherwise you win the trick. When you win a trick, you may meld a set of your cards. During the first phase
of the game, the second player does not have to follow suit, and they may trump to take a trick.

After the trick has been taken, and any possible meld laid down by the winner of the trick, each player takes a
new card from the stock - the previous trick winner taking first. The next trick is then played, the first card
being played by the winner of the previous trick.

When you take a new card from the stock, you click down on the top of the stock. The top card will then be
turned face up for you to see, and, when you release the mouse button, will be automatically added to your
hand. The first phase continues until the stock is depleted.



E Next panel: Watching a Game Being Played
Getting Started - Phase 2

If the opponent takes the penultimate card from the stock (before you take the last, upturned, card), it will be
shown to you.

After the stock is exhausted, the second phase of the round is played. This is more akin to a Whist game than
a Rummy game in that the objective is now to make points by taking tricks. However, unlike phase 1, players
must follow suit if they are able, they must trump when possible if they cannot follow suit, and they must play
a higher card than the led card if they are able. In other words, if a player can take a trick, they must. The
round ends when all the cards have been played.

The lead alternates on each successive round. The initial lead also alternates from game to game, unless the
"Cut For Deal" option has been selected under the "Dealing" tab of the "Edit - Preferences" menu option.

At any time you can get assistance on what to do next by clicking on the leftmost button in the status bar.



% Cycle back to: How to Play Pinochle

Watching A Game Being Played

If this is your first experience of Pinochle, you might prefer to watch a game being played before launching
into reading the help information in detail.

Follow the following steps to set Pinochle into AutoPlayer mode.

Select "AutoPlayer" from the "Assistant" menu

Select a skill level for the player. "Expert" would be a good choice. Press "OK"

Sit back and watch.

Press the "Stop AutoPlay" button on the status bar when you have watched for long enough.

A W N
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Understanding the Interface

The stock is shown face down to the left of the mat. The opponent's cards are displayed face down above the
mat, and the player's cards are displayed face up below the mat. Melds are displayed to the right of each
player's hand. Cards are played as tricks on the mat.

The scoresheet is displayed to the right of the mat.  If you have rule or bonus options selected, these will be
shown to the left of the mat, under the stock. The status bar along the bottom of the window displays
information about the game in progress as well as providing shortcut buttons to facilitate hand adjustments
and obtaining hints.

Select a topic:

Using the Mouse

Drag and Drop

Point and Click
Arranging Your Cards
The Scoresheet

Status Bar Counters
Shortcut Buttons

Visual and Sound Effects



E Next panel: Drag and Drop

Using The Mouse

Pinochle supports both "Drag and Drop" and "Point and Click" mouse operations. Point and Click operations
are performed by single clicking. Double-clicking is not supported.

For both methods of mouse operation, actions take effect when the mouse button is released, and are ignored
if the mouse button is released in a different area from where it was depressed when the "No Drop" cursor is
showing. The only exception is when taking a new card from the stock when the card will move to the
player's hand if the mouse button is released under the "No Drop" cursor.

The left mouse button must be used for all game operations except that of discarding from your hand.

The right mouse button is normally used to discard from your hand, although you may use the "Alt" key with
the left button if you prefer. Right-clicking will display a convenient PopUp of common menu options. If "Play
Protect" is selected, the PopUp menu displayed over the player's hand will include play confirmation as the
first option.

The AutoMouse features may be enabled to move the mouse automatically between the stock and the player
area and/or to and from the message and information windows.



E Next panel: Point and Click

Drag and Drop

"Drag and Drop" mouse operations are performed by clicking down on the mouse button above the card to be
moved, dragging the mouse pointer to the destination, and then releasing the mouse button. Unless
suppressed, the card will be dragged with the mousepointer - in which case the top left corner of the card is
considered to denote the pointer coordinates instead of the mousepointer itself.

The valid moves are:

e  Stock card to: player's hand
e Player's hand to: mat, meld, another part of player's hand

Cards may be melded from the player's hand singly or as a group. To move as a group, select the cards
using the point-and-click method and then drag one of the cards in the group to the right of your displayed
hand.



E Next panel: Arranging Your Cards

Point and Click

"Point and Click" mouse operations are performed by clicking down and releasing the mouse button on the
card to be moved and then clicking down and releasing the mouse button on the destination.

The valid moves are:

o Stock card to: player's hand
e  Player's hand to: mat, meld, another part of player's hand

Cards may be melded from the player's hand singly or as a group. To move as a group, select each of the
cards and then click to the right of your displayed cards. To move singly, meld the first card and then add
each of the additional cards by selecting and clicking on the melded card(s).

Note that the stock card is displayed as soon as you click down on it. When the button is released it will move
to the player's hand. Playing of a card is immediate upon a right click, unless "Play Protect" is selected from
the "Player" preferences tab.



E Next panel: The Scoresheet

Arranging Your Cards

By default, Pinochle automatically sorts and resorts the player's cards when dealt, and when new cards are
added to it. The default sortation is suit within rank. When the "Sort By Suit" option is selected from the
"Player" menu, the sortation is changed to be rank within suit. All sorting is performed in the order: Clubs,
Diamonds, Spades, Hearts. This improves color differentiation of adjacently displayed suits.

You may chose to arrange the cards yourself by selecting the "No Sorting" option from the "Player" preferences
tab. In this case, new cards are always added to the right of the hand. You may Drag and Drop cards to
the left and right within your hand to order them to your liking.

If you are familiar with MeggieSoft Games' Rummy 500 or Gin Rummy games, note that Pinochle does not
support a "reserved" set of cards. In Pinochle, the area to the right of the Player's unmelded cards is used to
display the Player's melded cards.

Remember that if you click on the left mouse button and release the button without moving the card, the card
will be selected for melding.



E Next panel: Status Bar Counters
The Scoresheet

The information on the scoresheet to the right of the mat is displayed as follows:

e  The scores for each completed round are added the scoresheet at the end of the round.

e After the second round of a game is completed, the running totals for the current game are displayed as a
sub-total line under the round scores.

e  Within a round, points earned from melding are displayed in italics in color. The running totals of points
melded during the first phase of the current round are displayed under the round scores, followed by the
running game totals.

e The trick points being accumulated are reported at the bottom of the scoresheet.

o If the scoresheet is about to become full, earlier round scores will be consolidated into a single line,
displayed in bold font.

Because the scoresheet is facing the player, it is maintained from the player's perspective - hence the player
is "Me" and the opponent is "You".

Select the "View - Round Scores" menu option to see the full details (including date and skill level) of all rounds
of the current game. These round scores are always shown individually, even if some have been consolidated
on the scoresheet to make more room (see above).



E Next panel: Shortcut Buttons
Status Bar Counters

The following counters are displayed in the status bar:

. Stock: The number of card remaining in the stock.

e Player (optional): The number of prior games won by the player.

. Opponent (optional): The opponent skill level and the number of prior games won by the opponent.
. Round: The current round number within the current game and the trump suit of the current round.
e Turn: The turn number within the current round.

. Meld (optional): The points value of the highest unplayed meld currently in the player's hand.

. Goal: The points required to win the game. Normally 1000 points, but increments by 250 points each
time that the players pass the goal together.



E Next panel: Visual and Sound Effects
Shortcut Buttons

You may click on the parts of the status bar described below in order to achieve the associated actions.

. Error Messages: Click on an error message to clear it.
e Query Symbol: Click to get assistance on what you can do at this point of your turn.
. Light Bulb: Click to get a hint.

. Undo: Click to undo your current turn and start over. Note that you cannot undo taking a new card from
the stock.

e  Card Alignment: Click to switch between normal and staggered display of the player's hand.

o Sort Order: Left-click on the sort order symbol to switch between rank sortation and suit sortation of the
cards in the player's and opponent's hands. Right-click on the sort symbol to inhibit automatic sorting of
the player's cards. The symbol will then be dimmed with an "X" over it. Right-click again to re-enable
automatic sorting.

. Color Melds: Click on the tint symbol to switch between white backgrounds and tinted backgrounds for
melded cards.

Where a shortcut button is associated with a Preference setting, the change is not saved. You must change
the setting via the "Edit - Preferences" menu option if you wish a change to be saved permanently.



E Cycle back to: Understanding the Interface
Visual and Sound Effects

Pinochle provides a number of visual effects and sound effects to improve realism and enhance your playing
pleasure. These are:

e Rounded card corners

e  Customizable color schemes

o "Wallpaper" effects for the main table window and the mat

e Animation and visual card dragging

e  Custom card-style mousepointers

o MIDI music support

e Sound effects

e  Synthesized speech output

The above may be selected, customized, and deselected via the "Preferences" option under the "Edit" menu.

Note that these effects make intensive use of processor and graphics resources and can reduce
responsiveness on slower or less graphics-capable systems. If you find Pinochle's interface to be sluggish,
you should experiment with disabling some of the visual and sound effects.
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Menus

The following drop-down menus are available:

Game Menu
Edit Menu
View Menu
Assist Menu

Help Menu



E Next panel: Edit Menu
Game Menu

The following selections are available under the Game Menu:

AutoPlayer
Change Players
Restart Round
Redeal Game
Reset Scoreboard
Save Scoreboard
Exit



E Next panel: View Menu
Edit Menu

The following selections are available under the Edit Menu:

nd

Swap Cards

Music Playing
Preferences

c
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E Next panel: Assist Menu
View Menu

The following selections are available under the View Menu:

Points Details
Round Scores
Game Scores

League Table
Hall Of Fame

Toggle Rules/Bonuses



E Next panel: Help Menu
Assist Menu

The following selections are available under the Assist Menu:

Analyze Hand
Review Tricks

Review Player Meld Types
Review Opponent Meld Types
Explain

Suggest
Recall

Distribution




E Cycle back to: Menus

Help Menu

The following selections are available under the Help Menu:

. Help On Help: Displays help regarding the use of the Microsoft Windows Help system.
e Main Contents: Displays the main Pinochle help window.
o Search Topics: Displays the Pinochle topics search window.

. Order Form: Displays a form for you to enter your name and address and print the order form to register
Pinochle.

e  Enter Registration: Permits you to enter or re-enter your registration number. Should the Pinochle
options data on your hard disk become missing, Pinochle will return to the unregistered status. In this
case, you will need to re-enter your registration details.

. ReadMe File (MeggieSoft Games): Displays the README.TXT file using the associated txt file program for
your system.

. ReadMe File (Pinochle): Displays the READPIN.TXT file using the associated txt file program for your
system.

e MeggieSoft Home Page: Accesses the MeggieSoft Games home page (Provided you have Internet
capability and an associated web browser)

e About: Displays information about the version number and author, and the registration confirmation.



E Next panel: Review Tricks

Analyze Hand

Select this option if you wish the assistant to analyze your hand.

The resulting display will indicate:

e  Meldable cards - those which could be melded the next time that you win a trick.

o Holdable cards - those which may be held in the hope of picking up a card from the stock which will
complete a meld. No account is taken of cards already seen; i.e., the required card may not still be in the
stock.

o Discardable cards - those which are unmeldable.
The specific possible melds and their points values are also displayed if meldable cards are found.



E Next panel: Review Player Meld Types
Review Tricks

Select this option to review the cards which comprise the tricks taken during the current phase of the round.



E Next panel: Review Opponent Meld Types

Review Player Meld Types

Select this option if you wish to be reminded of the meld types (pinochle, marriage, set, etc.) of the cards
displayed which have been melded by the player.

The resulting display will indicate which meld type each set of cards was melded as.



E Next panel: Explain

Review Opponent Meld Types

Select this option if you wish to be reminded of the meld types (pinochle, marriage, set, etc.) of the cards
displayed which have been melded by the opponent.

The resulting display will indicate which meld type each set of cards was melded as.



E Next panel: Suggest
Explain

When selected, the "Assist!" window will appear.
The Assist! window is context sensitive and will describe your alternatives at the current state of play.

You may move the Assist! window by dragging its title bar.



E Next panel: Recall

Suggest

When selected, Pinochle will examine your hand and display a reasonable series of actions for you to take.
(Pinochle does not take advantage of this knowledge when determining subsequent turns for the opponent.)

When it is your turn to take a card, the display will merely inform you to take a new card from the stock.
When it is your turn to play a card, Pinochle will suggest which card you should play and towards what goal
(discard, attempt a trick, win). If you could meld a card or cards from your hand, the display will include the
suggestion to lay down the meld with the highest points value (if there are alternative melding choices)
displayed.

You may select the "Do It" button when the suggestion box is displayed, and Pinochle will play the
suggestion(s) for you. If you select "Do It" and the suggestion includes a playing recommendation and a
meld, then if the trick is not won, the meld obviously won't be executed.

Pinochle employs the same logic for providing the suggestion as it does for playing the opponent's hand. The
method employed is the "Expert" skill level.



E Next panel: Distribution
Recall

The Recall facility is a powerful aid to those who cannot remember which cards have been seen during play. It
is not intended to be used frequently as an alternative to concentration, but may help you develop improved
powers of recall.

When this menu entry is selected, you will be asked if you wish to recall "Seen", "Unseen", or "Both".

"Seen" cards are listed in two parts: those in your hand that the opponent has seen you take from the discard
pile, and those that you have seen the opponent take.

"Unseen" cards are all those cards which are: not in your hand, not in the discard pile, not melded, and not
among those of the oppnent's cards that you have seen. They are therefore the content of the stock and the
unseen portion of the opponent's hand - but who knows which is where?



E Cycle back to: View Menu
Distribution

Select this option to see a map of all the cards and their current locations (tricks, melds, etc.) The display
does not identify the location of cards that the player has not seen which are either in the stock or in the
opponent's hand.



E Next panel: Round Scores
Points Details

Displays the scores of the player and the opponent for each of the melds and tricks of the current round.



E Next panel: Game Scores
Round Scores

Displays the winner, and the scores of the player and the opponent, for all previous rounds of the current
game.

The display includes the date and opponent skill level for each game.

The text colors (blue for wins, red for losses) may be changed via the "Edit - Preferences" menu option.



E Next panel: League Table
Game Scores

Displays the winner, and the scores of the player and the opponent, for all previous games played by the
currently active player.

The display includes the date and opponent skill level for each game.
A selection pad permits the display of the game history against the opponent at a particular skill level.

The text colors (blue for wins, red for losses) may be changed via the "Colors" tab of the "Edit - Preferences"
menu option.



E Next panel: Hall Of Fame
League Table

When selected, Pinochle will display the following information for all players for whom a saved scoreboard file
exists: Games Won, Games Lost, Points For, Points Against, Average (points for divided by games played)



E Next panel: Toggle Rules/Bonuses
Hall Of Fame

When selected, Pinochle will examine all saved scoreboards and display statistics such as highest and lowest
scores for and against, narrowest and widest winning margins, etc.



E Cycle back to: View Menu
Toggle Rules/Bonuses

Selecting this menu option will toggle between the rules display and the bonuses display.

You may also click on the Rules/Bonuses panel itself to achieve the same action.



E Next panel: Swap Cards

Undo

Select this option to undo your current turn and start it again.

This option is only enabled during your turn.  You cannot undo the opponent's turn, nor your previous turns.
You cannot return a seen card to the stock. Once you have played a card, you cannot turn back. Thus, the
undo feature only permits what a reasonable human opponent would permit.

If you have highlighted cards in your hand, the undo option will deselect them - even if there is nothing else to
undo.



E Next panel: Music Playing

Swap Cards

Select this menu option if you wish to swap cards with the Opponent. Pinochle will then swap the cards
currently in the player's hand with those in the opponent's hand.

This option not available once a player has played a meld during a round.

The purpose of the option is as a learning tool. It is not intended to be used to distort your true scoring ability
relative to your peers, as might be reported by the League Table and the Hall Of Fame.



E Next panel: Preferences
Music Playing

Select this menu option to see what MIDI music track is currently playing. You may then choose to skip or
stop the current music track if you wish to.



E Cycle back to: Edit Menu
Preferences

You may customize Pinochle to your taste by selecting Preferences from the Edit menu. The preference options
are changed under the following tabbed panels. If you want your changes saved for future sessions, ensure
that the "Save Properties" box is checked. Preferences are saved separately for each player.

Speech
Automatic
Messages
Player




E Next panel: Colors
Screen

The following preferences are available:

. Main Window Size: Depending upon your monitor resolution setting, up to five window sizes are
available, the fifth of which is "Custom". As an alternative to selecting a standard window size via
preferences, you may also resize the main window by dragging the lower left corner. The resulting size is
held as the Custom setting so that you can return to it later.

e Table Effect: Select if you want the main table window to be "wallpapered" with a bitmap file (bmp or wmf)
of your choosing.

. Mat Effect: Select if you want the mat to be "wallpapered" with a bitmap file (bmp or wmf) of your
choosing.

o Suppress 3D Effect: Select if you wish to disable the 3D effects in the main window.
¢ Hide Rules/Bonuses: Select if you wish the rules/bonuses panel to not be displayed.

o Game Score Display: Select "Title Bar" or "Status Bar" to display game scores elsewhere than the default
of in the main window.



E Next panel: Cards
Colors

The color preferences are used to provide on-screen adjustment of the colors displayed by Pinochle.

First, in the upper part of the window, select the target area for which you want to change the color. The
current color is displayed below the "Target" selection frame. If the target allows you to change both the text
and the background colors, select the one desired.

Second, click on the "New Color" button to select the color to which you require to change the target. The
standard Windows color selection window will be displayed. You will return to the color control window after
you have made your new selection.

If you wish to preview the effect of the change, click the "Preview" button. The revised color scheme will be
dynamically displayed "on-screen" in the main Pinochle window. If you cancel the preferences window after
previewing, the previous color scheme will be reinstated.

The "Reset" selection frame allows you to set all colors to how they were before you selected "Preferences", or
to the Pinochle default color scheme.



E Next panel: Card Back

Cards

Provided that the required image files exist in the same directory as Pinochle and your available video memory
resources permit, you may select any of four card display sizes. Note that the font size displayed in Pinochle's
main window, and the size of the status bar and speed buttons, are adjusted to correspond with the card sizes
larger than the regular size.

Alternatively, you may select either of the following:

o Do Not Automatically Resize: The card size will always be as specified, unless the window size is too small
to accomodate the selection - in which case it will be automatically reduced.

. Resize Per Window Size: Card size varies automatically with corresponding window size. (Custom window
sizes will select the nearest appropriate size).

e  Resize To Largest Possible: Card size varies one size larger than the corresponding window size. (Custom
window sizes will select the nearest appropriate size.)

Select "True Corners" for a more realistic card appearance with rounded instead of square corners. This may
result in a performance penalty when cards are displayed.

Select "Melded Cards In Color" to tint the cards that have been melded.

Select "Display Face-up" to show tricks face-up at the end of each round.



E Next panel: Dealing

Card Back

There are six standard card back designs available, plus you may use bitmap image file (bmp or wmf) of your
own design or choosing. Click on the Standard or Custom button to select the range required. Use the drop-
down list for standard cards or Browse to select a custom card design.

Pinochle does not provide graphic design capabilities, so it is assumed that you are able to scan, copy, or
design any custom image file(s) you require using other tools. You may also use other appropriately sized
bitmap files on your system.

The size of the "regular" card image is 71 by 96 pixels. If the image is larger, Pinochle will take the card back
from the upper left part of the design. Pinochle will automatically resize the card back design when card sizes
other than "regular" are selected.

You do not need to add the card frame (single pixel black line around the edge) or trim the corners. Pinochle
will do this automatically when it loads the card back image file, which will override your efforts anyway.



E Next panel: Animation
Dealing

The following preferences are available:

. Cut For Deal: Each game will start with a cut for deal. Otherwise, the lead alternates from game to
game. Cuts are determined by Pinochle card rank -- i.e., ten beats king.

e 64 Card Deck: A deck of sixty-four cards, which includes the Sevens and Eights of each suit (twice), will be
used. Dix is the seven of trumps.

e Deal 16 Cards: 16 cards are dealt to each player as four groups of four cards. (Available only with 64 card
deck.)

e Quick Deal: Cards are dealt as a single block instead of as groups of three or four cards. This speeds up
the display at the start of the game, at the expense of realism.

e Quiet Deal: Cards are dealt individually but the Place Card sound effect is inhibited during the deal. This
speeds up the display.



E Next panel: Sound
Animation

The following preferences are available:

. Suppress Card Animation: When selected, a card being moved automatically will disappear from the
source and reappear at the destination, instead of floating from the source to the destination.

e Suppress Animated Card Twisting: When selected, cards do not twist when floating, but are moved flat.

. Constant Travel Time: When selected, the duration of each animated card movement is the same.
Otherwise, the duration is distance dependent (i.e., cards move at a constant speed).

e Animation Speed: Select the flight time duration for when cards are moved automatically from source to
destination.

o Suppress Card Display When Dragging: When selected, a dragged card will not be displayed in motion
under the mousepointer.

o Use Standard MousePointers: When selected, the standard Windows mousepointers are used instead of
the special card-style mousepointers used by Pinochle .

Note that the 32-bit version of Pinochle is unable to attractively support card display and special
mousepointers when dragging cards. This is a limitation of the Microsoft 32-bit operating environment. The
32-bit version therefore requires that one of the latter two options is selected.



E Next panel: Music
Sound

This preference panel permits you to enable and disable sound effects, and to specify the sound effect files to
be used. Pinochle permits the optional association of a wav file with each of the nine events shown.

If you do not have a sound card, the speak.exe driver is a freely available Microsoft product which uses your
PC speaker to play (low quality) sound.

If your system has difficulty playing music and other sounds simultaneously, either do not enable the music
feature, or do not enable sound and speech features.

To change a sound effect, select the corresponding button. The name of the currently assigned file name will
be displayed. (If there is no associated sound file, [none] will be displayed.) To test the sound, press "Test".
To assign or change a sound file, press "Browse..." and select the required sound file. To break the association
between the file and the event, press "Clear".

Select "No Sound Synchronization" to prevent Pinochle waiting for silence between issuing sounds and/or
processing certain actions. When selected, processing will be faster, but sounds may cut each other off and
not synchronize well with actions. You should select this option only if your system is one that freezes as a
result of Pinochle's sound effects or speech processing.



E Next panel: Speech
Music

This preference panel permits you to enable and disable the playing of MIDI music files and to specify the
music file(s) to be played.

If your system has difficulty playing music and other sounds simultaneously, either do not enable the music
feature, or do not enable sound and speech features.

When music is playing, you may also select the "Music Playing" option (Edit menu) to display the name of the
file being played, to skip to the next MIDI file in the filefolder, or stop the music.

To change the music file from that displayed, press "Browse..." and select the required MIDI music file. (If
there is no currently associated file, [none] will be displayed.) To test the music, press "Test". To clear the
music file selection, press "Clear".

The available play modes are:

Single - the selected music file will be played once.

Repeat - the selected music file will be played repeatedly

Cycle - the music files in the filefolder will be played in sequence.
Random - the music files in the filefolder will be played in random order.



E Next panel: Automatic

Speech

When enabled, Pinochle will speak to you. The spoken phrases will include prompts, error messages,
confirmations, and score summaries. The facility will work with your PC's internal speaker (provided you have
Microsoft's speak.exe driver installed), but the quality is much better with a sound card.

The dictionary file contains pronunciation rules for non-standard words. If you wish to edit it you will need to
use the dictionary editor provided with the diskette version of Pinochle.

The voice font file defines the voice to be used. The default voice font is distributed with Pinochle. Alternative
voice files may be available for download from PC WholeWare's web site. There is a link to this site from the
MeggieSoft Games web site (see "About" under the Help menu for the URL).

You may set the pitch, tempo, and volume of the voice to your liking. Note that the "Test" Button is only
operative when the Speak-ToMe feature is enabled.

MeggieSoft Games has licensed the WinSpeech technology from PC Wholeware for inclusion with Pinochle. If
the Speech System is not included with your installation, you may download a copy from the MeggieSoft
Games web site or register for the diskette version.



E Next panel: Messages
Automatic

The following preferences are available:

e  AutoStart: When selected, the "Start" button will not appear in the status bar at the start of a player's
session. Note that preference changes before the start of a session may only be made when this button
is displayed.

e AutoResume: When selected and multiple players are defined, Pinochle will remember which player was
playing when it exits, and will automatically start up for that player when Pinochle is next run.

e  AutoMouse - Cards: When selected, the mouse pointer automatically moves: (i) to your hand when you
take a new card from the stock or you take one or more cards from the discard pile, and (ii) back to the
stock after you discard.

e  AutoMouse - Dialogs: When selected, the mouse pointer automatically moves to any message or
information windows which are displayed and, if "AutoMouse - Cards" is also selected, back to the player's
hand or the stock after the dialog window is dismissed. Some mouse drivers and add-in utilities also
perform this function. Therefore this is a separately selectable option within Pinochle.

The AutoMouse facilities are intended to reduce potential carpal tunnel strain for avid players of Pinochle.



E Next panel: Player
Messages

The following preferences are available:

. Display Error Box: When selected, error messages displayed by Gin Rummy are shown as dialog boxes
(with an "OK" button) instead of in the status bar.

e Suppress Tool Tips: When selected, Tool Tips are not displayed when the mouse is positioned over one of
the speed buttons in the status bar.

e Suppress Status Messages: When selected, status messages are not displayed in the status bar during
play. Error messages will continue to be displayed as appropriate. Note that opting to have game scores
displayed in the status bar automatically supresses status messages.

. No Start Reminders: When selected, the reminder of who starts the next round or game is suppressed.

e No Bell: When selected, the bell/beep sound associated with errors is suppressed. It is recommended
that the "Display Error Box" option be selected in this situation so that error messages don't go unnoticed.



E Next panel: Opponent

Player

The following preferences are available:

. Play Protect: The playing of a card requires confirmation from the resulting PopUp menu.

e Meldable Card Warning: Confirmation will be requested if the player is about to play a card which could
be melded.

¢ Automatic Knock: A game will automatically end if the player passes the game points goal during the
melding phase of a round.

o Do Not Sort: The player's hand is not automatically sorted as cards are added to it.
. Sort By Suit: The sort criterion is set such that cards will be sorted by rank within suit.

e Stagger Hand: The cards in the player's hand will be displayed such that the suits are vertically offset
from each other.

e Display Meldable Points: Adds a counter to the status bar which shows the value of the highest meld in
your hand.



E Next panel: Rules

Opponent

The following preferences are available:

. Skill Level: Select the skill level required from the six ascending skill levels listed in the drop-down box.

Quick Display: When selected, Gin Rummy does not enact the 400 millisecond pause between each of
the opponent's actions.

o Suppress Card Highlighting: When selected, the highlighting of the card played by the opponent will be
suppressed.

. Suppress Stock Highlighting: When selected, the highlighting of a card taken from the stock by the
opponent will be suppressed.

o Show Cards: When selected, shows the opponent's cards face up.



E Next panel: Bonuses
Rules

The following preferences are available:

. Score All Tricks: Trick scores are also earned in the first phase and added to the round score at the end of
the round.

e Score By Round: Points earned during a round, including those from melds, are added to each player's
game total at the end of a round.

e Simplified Scoring: Queens and Kings are scored with a trick points value of five; and Tens and Aces are
scored as worth ten points.

e  Red Pinochle: Pinochle comprises a Queen of Hearts and a Jack of Diamonds instead of the more common
combination of a Queen of Spades and a Jack of Diamonds.

e Dix Alone: A dix may not be melded in the same turn as another meld.
. Roundhouse: Permit melding of an eight-card combination of four different marriages.

. Must Overplay: During the second phase of a round, the following player must not only follow suit if
possible, but must also play a higher card of that suit, if possible, irrespective of the suit led.



E Cycle back to: Edit Menu

Bonuses

The following preferences are available:

Dix Dealt: 10 points for melding a Dix are awarded to the dealer when the upturned card is a Dix.

Roundhouse: When the "Roundhouse" rule option is selected, a Roundhouse is awarded 240 points instead
of the normal 220 points.

Last Trick: 10 points are awarded to the winner of the last trick of a round.



E Next panel: Change Players

AutoPlayer

AutoPlayer puts Pinochle into a fully automatic mode whereby both the opponent's and the player's hands are
played alternately by the computer. AutoPlayer is a valuable learning facility for new users who wish to watch
the game being played before playing it themselves.

When the AutoPlayer option is selected, you may be asked if the updated scoreboard for the current player is
to be saved. Respond "yes" if you wish to recover to the current state after AutoPlayer has finished,
otherwise recovery will be to the point that the scoreboard for the current player was last saved.

You will be asked to define which of the six skill levels is to be used by the player. The opponent will play at the
skill level in operation when AutoPlayer is selected. After the player skill level has been selected and you
have selected "OK", just sit back and enjoy the view. When you have seen enough, press the "Stop AutoPlay"
button in the middle of the status bar.

When it is stopped, AutoPlayer will permit you to display the game scoreboard for the AutoPlay session, if at
least one game was completed. After the AutoPlayer is dismissed, Pinochle returns to the previous player's
game.



E Next panel: Restart Round

Change Players

Select this menu option to switch to another player, to add a new player, or to remove a player.

. Switch: Select the incoming player name, and press the "Switch" button. You may select any named
player except yourself (the current player). When switching players, you will first be asked if the
scoreboard for the outgoing player is to be saved, if it has changed since it was last saved.

e Add: When you first use Pinochle, the only player is "Default". Use the "Add" button to add more
players. When you select the "Add" button, a sub-window will appear, into which you will enter the name
for the new player. Press "OK" to create a scoreboard for the new player. Enter players' names as 1-8
letters and numbers. Spaces, punctuation marks, and special characters are not permitted. Irrespective
of how you specify upper and lower case, Pinochle will always display the player names in lower case with
the first letter capitalized. You may have up to 12 named players at any time

o Remove: Select the player name to be removed, and press the "Remove" button. You may select any
named player except yourself (the current player). You will be asked to confirm that the player is to be
removed, after which the scoreboard file and the saved options for the player will be permanently deleted
from your system.



E Next panel: Redeal Game

Restart Round

Select this menu option to to restart the current round. Pinochle will abandon the current round and restart it
from the beginning, without shuffling the cards.



E Next panel: Reset Scoreboard
Redeal Game

Select this menu option to start a new game. Pinochle will abandon the current game, reset all counters and
scores, and shuffle the cards before dealing.

This action restarts only the current game. Thus, if you are currently on game 3, the play will restart at round
1 of game 3.

If you want to start over from the beginning of game 1, select "Reset Scoreboard".



E Next panel: Save Scoreboard
Reset Scoreboard

Select this menu option to reset your game scoreboard to zero. The game counter will return to game
number 1.

If you are partway through a game, the scores of the previous rounds of the game are not cleared. Thus you
can make the current game the first of your new scoreboard.

The previously saved copy of your scoreboard is not erased by this action. You must use the "Save
Scoreboard" option to replace the previous scoreboard with the new one.

If you clear the scoreboard and decide you would have preferred not to have done so, exit Pinochle (or change
players) and respond "No" when asked if the updated scoreboard is to be saved.



E Next panel: Exit
Save Scoreboard

Select this menu option to perform an immediate save of the current scoreboard status (games and rounds)
for the current player.

This option is useful if you are enjoying an extended session of Pinochle and don't want to wait until you exit
Pinochle, or change players, before your updated scoreboard status is safely saved to disk.



E Cycle back to: Game Menu
Exit

Terminates the session and exits from Pinochle.

Before exiting, Pinochle asks if you want to save the updated scoreboard for the current player, if it has
changed since it was last saved.

If you respond "Yes", Pinochle will save the scores of all previous games and the scores of the rounds of the
current game (if not yet completed) for the current player. When this player next plays Pinochle, this
information will be restored automatically and play will proceed with the same game number and round
number.

If you respond "No", the scoreboard information will not be updated and when the current player next plays
Pinochle, the situation will be as it was previously.

If, when you next play Pinochle, you start part way through an unfinished game (e.g., round four) and you
wish to restart from round one of the game, use the "Redeal Game" option.

Note that Pinochle only saves the scores of games and rounds completed. It does not save the card
distribution if you exit Pinochle partway through a round.



E Cycle back to: Contents
Miscellaneous Information

The following topics are included to help you learn more about Pinochle, and enhance your enjoyment of the
game:

About The Opponent
Skill Levels

How To...

Saved Information
Strategies

Increasing Performance
Troubleshooting
Technical Construction

Third Party Components



E Next panel: Skill Levels

About The Opponent

The opponent plays automatically after you have taken a card, after the opponent has taken a trick, or when it
is the opponent's turn to start a round.

The opponent skill level may be set at any of six levels from the "Skill Level" option under the "Opponent"
menu.

When the opponent takes a new card from the stock, it will briefly highlight the stock as confirmation.

The opponent also pauses briefly (about two fifths of a second) after taking a card and between each of
multiple melds so that the actions of its turn can be clearly viewed.

If desired, the highlighting features and the pause can be turned off via the "Opponent" tab of the "Edit -
Preferences" menu option.



E Next panel: How To...

Skill Levels

Six skill levels are available, in ascending order of difficulty from Carefree to Master. The three higher levels
are the most time consuming of the skill levels, and may be frustrating on a slow processor. However, they
make for the most challenging game and are relatively hard to beat.

When rounds and games are recorded on the scoreboard, the skill level of the opponent is also saved. If the
opponent skill level is changed during a round or game, then the skill level recorded is the highest that was
used during the round or game.

Relative Performances

The scores from 100 game test series for each combination of skill levels are shown below. These results
should be taken as an approximate guide only.

e Standard vs. Novice: 82 -12 (24% more points)

o Expert vs. Standard: 66 - 34 (7% more points)

o Champion vs. Expert: 61 -39 (6% more points)

e  Master vs. Champion: 70-30 (13% more points)

Carefree very rarely wins because it never melds. It is therefore not included in the above.



E Next panel: Saved Information
How To ...

How to save personal preferences

All options changed via the "Edit - Preferences" menu option are saved when the "Save Preferences" option at
the bottom of the Preferences window is checked.

How to recover a reset scoreboard

Scoreboards are only permanently saved when you select "Save Scoreboard", or when you respond "Yes"
when exiting Pinochle or changing players. If you have reset your scoreboard and would have preferred no to
have done so, just exit Pinochle and respond "No" to the prompt "Save updated scoreboard...?" When you
restart Pinochle, your previous scoreboard will be active.



E Next panel: Strategies
Saved Information

Information is saved between Pinochle sessions in the Registry (32-bit version) or PINOCHLE.INI (16-bit
version) as follows:

Registration
If you are a registered user, your name and encoded registration are stored.

AutoResume

When AutoResume is active, the name of the last player is maintained. Thus AutoResume always recovers
the state that it was when the previous session exited.

Personal Options

The options (configuration, player, opponent, and rules) for each player are saved. For example, Jane's
options will be saved in the section named "Jane".

Personal Scoreboards

Each player's scoreboard is saved in the Pinochle directory as xxxxxx.psb, where xxxxxx is the player's name.
Pinochle considers a player to be currently defined by whether a scoreboard file exists for the player,
irrespective of whether options are saved for that player. An empty scoreboard file is created for a player
when their name is added via the "Add Player" menu option.

To clear the scoreboard completely, use the "Reset Scoreboard" option of the "Scoreboards" menu.



E Next panel: Increasing Performance
Strategies

Selecting which card to play (phase 1)

If it is early in the round, you may benefit from taking an opponent-led trick rather than leading a possibly
unnecessary high card. Even if you lead a high card, the opponent may not follow suit and may trump it.
Tens have little melding value since only the Ten of Trumps can be melded (as part of a flush), but they can be
valuable for taking tricks in either phase. If you suspect that the opponent has high potential to play melds,
you might be more aggressive in taking tricks (even if you cannot meld) as a blocking measure.

Melding

Use as many already melded cards as possible to avoid letting the opponent see more of your hand than is
necessary. Unless the "Dix Alone" rule option is in effect, meld Dixes in the same turn as another meld.

Selecting which card to play (phase 2)

Take as many early tricks from your Aces and Tens as possible -- otherwise the opponent may amass points
from them. Remember that the leader wins a trick that is comprised of matching cards. If you have some
Aces and Tens of Trumps, or if you believe you have more trump cards than the opponent, draw out trump
cards early.



E Next panel: Troubleshooting
Increasing Performance

Pinochle includes Preference options that are intensive of graphics processing. You should select these if you
want more realism, but deselect them if graphics performance suffers unacceptably. These options are:

True Corners

Card Dragging

"Place Card" Sound Effect.
Animation

Table Effect and Mat Effect
Tinting of Melds
Staggered Hand

If the speed of the deal is the only aspect that you find frustrating, consider using the "Quick Deal" or "Quiet
Deal" under the "Deal" preferences tab. Also, consider selecting the "Quick Display" option under the
"Opponent" preferences tab if the opponent is too slow for your liking. This will remove the 0.4 second delay
between the opponent's actions. Selecting the respective "No Highlight" options under the "Opponent" tab
will inhibit discard and stock highlighting and the associated 0.2 second delay.



E Next panel: Technical Construction
Troubleshooting

Most problems encountered are a result of one of the following:

. Graphics driver conflict, usually manifested by the display of blank white cards. Check that you have the
latest drivers from your graphics card manufacturer. Otherwise configure your system to use a graphics
setting with fewer colors (256 or 16), or disable Table Effect and Mat Effect, and perhaps Custom
Cardback, if you have these selected..

o Sound processing conflict. If your system freezes when sound effects and/or speech is enabled, try
setting "No Sound Synchronization" under the "Sound" preferences tab. Note also that some sound cards
may exhibit problems when attempting to play music and sounds/speech together.

o Corrupt scoreboard file. Under the "Change Players" option of the "Game" menu, remove the player for
whom the problem occurs and re-add. Alternatively, exit Pinochle and delete the corresponding
xxxxxx.psb file from the directory where Pinochle resides and then re-add the player from within Pinochle.

If all else fails, delete the directory where Pinochle resides, and reinstall.



E Next panel: Third Party Components
Technical Construction

Pinochle is programmed in Microsoft Visual Basic, Version 4.

Pinochle works from a bitmap of all the card images and makes extensive use of the Windows API BitBIt
function. Because of this, Pinochle is fast, but consumes some RAM and GDI resources. Alternative methods
of managing the user interface proved to be more processor intensive and less conducive to fluid play. The
trade-off was made for performance at the cost of resource consumption.

Pinochle is developed on a Pentium 60 with 48 MB of RAM. Testing is performed both on this system under
Windows 95, and (for the 16-bit version) on a 486-33 class system with 8MB of RAM under Windows 3.1.



E Cycle back to: Miscellaneous Information

Third Party Components

Although Pinochle does not use a dll for card drawing (for performance reasons), Stephen Murphy's excellent
freeware "qcard.dll" was used to create the bitmaps which Pinochle uses. The card back designs included in
qcard.dll were created by Daniel Di Bacco. Acknowledgments are extended to each of them.

The Pinochle help system was created using Firas Bushnaq's powerful "Visual Help".
Visual Help is a shareware product licensed by the author.

The "Speak-To-Me" feature uses PC WholeWare's WinSpeech technology, which has been licensed by
MeggieSoft Games for use with Pinochle.



E Cycle back to: Contents

About MeggieSoft Games

MeggieSoft Games is committed to the development of quality two-handed card games for the Microsoft
Windows environment. We currently offer three games: Rummy 500 (first released in 1994), Gin Rummy
(1995), and Pinochle (1996).

Select a topic:

Rummy 500
Gin Rummy

For latest versions, news, etc., visit us on the Internet's Worldwide Web at: http://members.aol.com/meggiesoft



E Next panel: Gin Rummy
Rummy 500

Rummy 500 is oriented towards building the highest possible score from creating melds.

A round of Rummy 500 starts with each player being dealt thirteen cards. As the round progresses, each
player picks up from the stock or the discard pile, melds if desired, and discards a card. The following are the
major features of the game:

e Any number of cards from the discard pile may be taken, provided the earliest discarded of them is
melded immediately. The remainder are added to the player's hand.

o Players may lay down melds, or add to each other's melds, at any time that it is their turn. Melding
scores points and reduces the liability of points in a player's hand, but gives the opponent a greater
chance of scoring points from melding some of their cards.

¢ Around ends when one of the players has melded or discarded their last card, or when the stock is
exhausted. There is no lay-off of deadwood; what the other player holds when the round ends counts
against them.

e The first player to score 500 points wins the game.

Rummy 500 uses the same basic Graphical User Interface (GUI) as MeggieSoft Games' Gin Rummy and
Pinochle. Thus the display and the use of the mouse is similar in all three games.



E Cycle back to: About MeggieSoft Games

Gin Rummy

Gin Rummy is oriented towards who goes out (knocks) first and who has the lesser amount of unmeldable
points remaining in their hand.

A round of Gin Rummy starts with each player being dealt ten cards. As the round progresses, each player
picks up from the stock or the discard pile, melds out their hand (knocking) if able, and discards a card. The
following are the major features of the game:

e The last discard may be picked up as alternative to taking a new card from the stock

e Melds are only played when a player knocks. A player must have ten or less points of deadwood in order
to knock. The knocking player then lays down their melds, and the other player follows by laying down
their meldable cards. This ends the round.

e The points scored are based upon the difference in deadwood points between the players; plus bonuses
for knocking, undercutting (having less deadwood than the knocker), and winning a game (100 points).

Gin Rummy supports all well documented variations including: Hollywood Scoring, Oklahoma Gin, and 11 Card
Gins.









